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ABSTRAK 
Enzim superoksida dismutase (SOD) memiliki fungsi sebagai antioksidan yang dapat menetralisir 

radikal bebas di dalam tubuh. Meskipun krokot telah terbukti memiliki sifat antioksidan, belum ada 

penelitian mengenai apakah batang krokot dapat meningkatkan aktivitas SOD dan jenis senyawa 

yang terlibat dalam peningkatan aktivitas tersebut. Oleh karena itu, penelitian ini dilakukan untuk 

mengevaluasi potensi batang krokot sebagai peningkat aktivitas SOD dan jenis senyawa pada batang 

krokot yang berperan dalam peningkatan aktivitas tersebut melalui penambatan molekuler dengan 

reseptor SOD PDB ID 1CB4. Penelitian ini melibatkan identifikasi senyawa pada batang krokot 

menggunakan teknik LC-MS/MS QTOF, prediksi bioavailabilitas dan toksisitas, serta penambatan 

molekuler. Hasil penambatan molekuler dievaluasi melalui parameter energi bebas Gibbs (∆G), 

konstanta disosiasi (Kd), dan residu yang terikat antara reseptor dan ligan. Berdasarkan hasil 

penelitian, xanthosine merupakan senyawa dengan potensi terbaik dalam meningkatkan aktivitas 

SOD dengan nilai (∆G) sebesar -7,00 kkal/mol dan Kd sebesar 7,37 µM. Selain itu, xanthosine terikat 

pada situs aktivator alosterik enzim berdasarkan identifikasi residu yang terikat antara reseptor dan 

ligan. Berdasarkan hasil penelitian, batang krokot berpotensi menjadi aktivator superoksida 

dismutase secara in silico. 

 

Kata kunci: Antioksidan, Batang Krokot, Penambatan Molekuler, Superoksida Dismutase 

 

ABSTRACT 
Superoxide dismutase (SOD) is an enzyme that acts as an antioxidant in the human body. 

Antioxidants can counteract free radicals in the body. Although purslane has been shown to have 

antioxidant properties, it is uncertain whether the stems of the plant can increase SOD activity and 

what types of compounds are involved in this process. This study was conducted to examine the 

potential of purslane stems to increase SOD activity and the compounds in purslane stems that 

contribute to this activity through molecular binding to the SOD PDB ID 1CB4 receptor. The study 

involved the analysis of compounds in purslane stems using LC-MS/MS QTOF, followed by the 

prediction of their bioavailability and toxicity, and then molecular docking. The results were 

analyzed using Gibbs free energy (∆G), dissociation constant (Kd), and binding residue between the 

receptor and the ligand. Xanthosine was found to be the best candidate for increasing SOD activity, 

with a value of (∆G) of -7.00 kcal/mol and a Kd of 7.37 µM. Additionally, the residue binding 

analysis indicated that xanthosine binds to the allosteric sites of the enzyme activator. Therefore, it 

can be concluded that the stems of purslane have the potential to activate superoxide dismutase in 

silico.  
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PENDAHULUAN 

Krokot (Portulaca oleracea L.) adalah 

tanaman yang dapat dimanfaatkan sebagai 

antioksidan dan masih dianggap sebagai gulma 

atau tanaman liar di Indonesia. 

Penelitian [1] menyatakan bahwa krokot 

yang sudah dewasa memiliki total fenolik dan 

aktivitas yang lebih tinggi dibandingkan dengan 

krokot yang masih muda. Krokot jenis Portulaca 

grandiflora Hook. memiliki aktivitas antioksidan 

sedang pada batang yang sudah tua dengan 

LC50 sekitar 100-150 ppm [2]. Senyawa 

oleracein C, D, dan E pada krokot memiliki 

aktivitas antioksidan yang lebih tinggi 

dibandingkan dengan butylated hydroxyanisole 

[3]. Pengujian aktivitas antioksidan krokot 

dilakukan secara in vitro melalui metode 2,2-

diphenylpicrylhydrazyl (DPPH) dan Ferric 

Reducing Antioxidant Power (FRAP). Suhu 

ekstraksi sampel sangat mempengaruhi aktivitas 

antioksidan. Pemanasan pada proses ekstraksi 

dapat menurunkan aktivitas antioksidan sampel 

[4]. Konsumsi sayuran yang memiliki aktivitas 

antioksidan dapat merangsang produksi 

antioksidan enzim dalam tubuh, seperti 

superoksida dismutase.  

Superoksida dismutase (SOD) adalah suatu 

enzim yang membantu memecah molekul 

oksigen yang berpotensi berbahaya bagi sel. 

Fungsinya adalah untuk mencegah kerusakan 

sel. SOD termasuk ke dalam golongan 

metaloenzim dan dapat ditemukan pada semua 

sel hidup [5]. Radikal bebas yang muncul dari 

metabolisme tubuh, salah satunya adalah 

Reactive Oxygen Species (ROS), dapat diatur 

kadarannya oleh enzim SOD. Enzim SOD 

mengkatalisis dismutasi dua molekul anion 

superoksida (∗O2) menjadi hidrogen peroksida 

(H2O2) dan molekul oksigen (O2). Sehingga 

anion superoksida yang berbahaya dapat 

menjadi lebih aman [6].  

Belum ada pengujian mengenai aktivitas 

enzim SOD pada batang krokot, meskipun 

beberapa penelitian menunjukkan bahwa krokot 

memiliki aktivitas antioksidan yang baik. Oleh 

karena itu, dilakukan penelitian in silico untuk 

mengevaluasi potensi batang krokot terhadap 

aktivitas enzim SOD. Pendekatan in silico 

menggunakan metode komputasi yang 

memungkinkan prediksi cepat untuk sejumlah 

besar senyawa dengan tingkat keluaran yang 

tinggi. Keuntungan lain dari metode in silico 

adalah kemampuannya untuk membuat prediksi 

berdasarkan struktur senyawa sebelum senyawa 

tersebut disintesis. Oleh karena itu, metode in 

silico dapat digunakan pada tahap awal 

pengembangan obat. Selain itu, dalam penelitian 

ini dilakukan identifikasi senyawa dalam batang 

krokot menggunakan LC-MS/MS QTOF untuk 

mengetahui komponen-komponen yang ada 

dalam batang krokot.   
 

METODE PENELITIAN  
Bahan: Krokot (Portulaca oleracea L.), 

akuades, struktur 3D enzim superoksida 

dismutase yang diambil dari basis data RSCB 

Protein Data Bank dengan kode PDB ID 1CB4 

dalam format .pdb. Ligan uji dari senyawa 

krokot (P. oleracea L.) dalam format .sdf dan 

ligan pembanding beta amyrin dalam format .sdf 

juga digunakan.  

Alat: Oven, blender, panci, kompor, botol gelap, 

wadah plastik, saringan, LC-MS/MS QTOF, 

laptop Acer A314-22 dengan spesifikasi 

prosesor AMD Athlon 3020e, RAM 8GB 

DDR4, dan sistem operasi Windows 11. Selain 

itu, simulasi penambatan molekuler dilakukan 

menggunakan beberapa perangkat lunak seperti 

YASARA Structure, Discovery Studio Visualizer, 

dan PyMOL. 

 

Metode 

Identifikasi Krokot 

Krokot yang digunakan dalam penelitian ini 

berasal dari Kabupaten Banyumas, Jawa 

Tengah. Sebelum digunakan, spesies krokot 

harus diidentifikasi terlebih dahulu untuk 

memastikan keakuratan penelitian. Identifikasi 

dilakukan dengan mengirimkan sampel krokot 

ke Pusat Penelitian Biologi, Lembaga Ilmu 

Pengetahuan Indonesia (LIPI). 

Preparasi Sampel Krokot 

Krokot yang digunakan dalam penelitian ini 

diperoleh dari Kabupaten Banyumas, Jawa 

Tengah dan bagian tanaman yang digunakan 

adalah batang. Batang krokot yang dipilih 

kemudian dibersihkan dan dikeringkan di dalam 

oven dengan suhu 50°C selama 2-3 hari. Setelah 

itu, batang krokot yang telah kering dihaluskan 

menggunakan blender. Simplisia batang krokot 

yang sudah halus dimasukkan ke dalam wadah 

plastik dan diikat kuat, kemudian disimpan pada 

suhu ruang. 

Maserasi Krokot 

Teknik maserasi yang digunakan pada 

batang krokot adalah perebusan. Sebanyak 30 

gram simplisia batang krokot dilarutkan dalam 

600 mL akuades dengan perbandingan 1:20. 

Kemudian direbus dengan suhu 100 oC selama 

30 menit menggunakan kompor.  
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Setelah itu, hasil rebusan disaring dan 

dikonsentrasikan menggunakan Vacuum Rotary 

Evaporator dengan suhu 50 oC.  

Untuk menghitung rendemen batang krokot 

hasil maserasi, digunakan rumus:

 

Identifikasi Senyawa pada Batang Krokot 

menggunakan LC-MS/MS QTOF 

Sampel yang telah melalui rotary 

evaporator diuji menggunakan teknik LC-

MS/MS QTOF. Pada teknik ini, fase gerak cair 

dialirkan melalui kolom dan cuplikan 

dimasukkan ke dalam fase gerak melalui 

penyuntikan. Setiap komponen pada sampel 

dipisahkan dalam kolom, dimana komponen 

dengan interaksi lebih lemah dengan fase diam 

akan keluar dari kolom lebih dulu dibandingkan 

dengan komponen dengan interaksi yang lebih 

kuat. Kemudian, detektor akan mendeteksi 

keluarnya setiap larutan dan merekam hasilnya 

dalam bentuk kromatogram. 

Preparasi Struktur dan Identifikasi Stabilitas 

Ligan 

Untuk mempersiapkan struktur ligan, 

digunakan perangkat lunak YASARA Structure. 

Seluruh ligan diunduh dari database PubChem 

https://pubchem.ncbi.nlm.nih.gov/ dalam 

struktur 3D dengan format .sdf. Setelah 

membuka perangkat lunak YASARA Structure, 

klik “File” > “Load” > “Other format” > Pilih 

“sdf - MDL MOLL” pada kolom format dan 

pilih file .sdf senyawa ligan yang akan 

dikonversi. Kemudian, ion hidrogen 

ditambahkan dengan cara klik “Edit” > “Clean” 

> “All”. Geometri ligan dioptimasi dengan 

mengklik “Option” > “Choose Experiment” > 

“Energy minimization” sehingga akan muncul 

simCell di sebelah kanan. Proses minimisasi 

dilakukan sebanyak 3x ulangan. Ligan hasil 

minimisasi disimpan dalam format .pdb dengan 

cara klik “File” > “Save as” > “PDB file” > pilih: 

Sequence 1: “Nama Ligan” > “Rename senyawa 

ligan tersebut”. Setelah itu, ligan dibuka kembali 

pada perangkat lunak YASARA Structure dan 

disimpan dalam format .sdf. Untuk 

mengidentifikasi bioavailabilitas ligan-ligan 

tersebut berdasarkan aturan Lipinski, digunakan 

situs web http://www.scfbio-

iitd.res.in/software/drugdesign/lipinski.jsp. 

 

Prediksi Toksisitas Ligan 

Cara memprediksi toksisitas ligan uji adalah 

dengan menggunakan webserver ProTox II.  

 

Pertama-tama, ligan uji diunduh dari laman 

PubChem dalam format SMILES. Kemudian, 

struktur ligan uji dengan format SMILES 

tersebut diunggah ke laman https://tox-

new.charite.de/protox_II/ . Untuk menguji 

toksisitas, pilih "Predict" dan hasilnya akan 

ditampilkan dalam beberapa saat. 

 

Preparasi Struktur Reseptor 

Untuk mempersiapkan reseptor, kita perlu 

mengunduhnya dari website RSCB Protein Data 

Bank www.rscb.org/pdb dengan menggunakan 

kode PDB ID 1CB4. Selanjutnya, enzim SOD 

yang dipilih memiliki resolusi 2,30 Å. Untuk 

mempersiapkan reseptor, molekul air harus 

dihapus dengan mengklik “Edit” > “Delete” > 

“Waters”. Ion hidrogen kemudian ditambahkan 

dengan mengklik “Edit” > “Clean” > “All”. 

Antarmolekul juga harus dipisahkan dengan 

mengklik “Edit” > “Split” > “All” > pilih “Do 

Not…” dan “Keep current object…” > “Split at 

all molecules”. Untuk menampilkan ion 

hidrogen pada gugus fungsi tertentu, klik 

“View” > “Hide atoms” > “Aliphatic 

hydrogens”. Setelah itu, hasil persiapan dapat 

disimpan dalam format .pdb pada folder kerja. 

Akhirnya, stabilitas reseptor dapat diidentifikasi 

menggunakan diagram Ramachandran. 

 

Validasi Gridbox 

Validasi dilakukan dengan menggunakan 

perangkat lunak YASARA structure. Pada 

validasi ini, reseptor superoksida dismutase 

(SOD) dengan kode PDB ID 1CB4 tidak 

memiliki ligan alami yang terikat pada 

strukturnya. Validasi gridbox dilakukan dengan 

membuat gridbox di sekitar residu sisi 

pengikatan ligan pada reseptor. Gridbox dibuat 

dengan rentang 0.5 - 5.0Å dan selisih 0.5Å. 

 

Penambatan Molekuler 

Ligan uji dan reseptor dalam format .pdb 

harus diubah ke dalam format .scene. Kemudian, 

pada opsi "macro & movie" pilih "macro" dan 

jalankan "dock_runscreen.mcr".  

https://pubchem.ncbi.nlm.nih.gov/
http://www.scfbio-iitd.res.in/software/drugdesign/lipinski.jsp
http://www.scfbio-iitd.res.in/software/drugdesign/lipinski.jsp
https://tox-new.charite.de/protox_II/
https://tox-new.charite.de/protox_II/
http://www.rscb.org/pdb
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Hasil penambatan molekuler dapat dibaca 

dalam format .log di folder kerja. Untuk 

mengidentifikasi interaksi hidrogen dan 

hidrofobik dari hasil penambatan, gunakan 

perangkat lunak Discovery Studio Visualizer. 

Selanjutnya, untuk melakukan visualisasi 

3D, gunakan perangkat lunak Pymol. 

 

 

 

HASIL DAN PEMBAHASAN 
Rata-rata rendemen ekstrak yang diperoleh 

sebesar 9,95 ±0,015. Untuk mengidentifikasi 

kandungan senyawa krokot, digunakan metode 

LC-MS/MS QTOF. Hasil identifikasi 

menunjukkan bahwa krokot mengandung 14 

senyawa yang tergolong ke dalam golongan 

alkaloid, flavonoid, saponin, dan triterpenoid 

(Tabel 2). Senyawa yang paling banyak adalah 

alkaloid, sedangkan saponin merupakan 

senyawa yang paling sedikit.  

Beberapa senyawa yang tercatat dalam 

tabel berwarna kuning tidak memiliki kode CID 

dan tidak terdaftar dalam Bank Data Online, 

sehingga tidak tersedia struktur 2D atau 3D 

untuk dilakukan penambatan molekuler.  

 

Tabel 1. Senyawa pada ekstrak krokot yang teridentifikasi dengan LCMS/MS QTOF 

 

 

Dalam penelitian ini, digunakan 11 ligan uji 

yang berasal dari senyawa pada batang krokot 

(Tabel 2). Sebagai ligan pembanding, digunakan 

beta amyrin. Ligan uji dan pembanding diunduh 

dalam bentuk 3D dengan format .sdf dari laman 

PubChem. Setelah itu, ligan-ligan tersebut 

dipreparasi dengan menambahkan ion hidrogen 

dan dilakukan optimasi geometri menggunakan 

perangkat lunak YASARA Structure. Untuk 

mencari posisi dengan energi terendah, proses 

minimisasi energi diulang sebanyak tiga kali 

sampai tercapai energi minimum keseluruhan.  

Hasil identifikasi bioavailabilitas 

menunjukkan bahwa terdapat empat ligan yang 

memiliki massa molekul lebih besar dari 500 Da, 

yaitu Ginsenoside F3, Oleracein A, Oleracein C, 

dan Oleracein D (Tabel 3). 

Jumlah donor dan akseptor ikatan hidrogen 

merupakan   descriptor    molekuler     mendasar  

 

untuk memprediksi bioavailabilitas kandidat 

obat kecil. Donor dan akseptor ikatan hidrogen 

mempengaruhi difusi pasif dalam melewati 

membran sel.  

Jumlah donor/akseptor yang terlalu banyak 

dapat merusak partisi dan permeabilitas 

membran obat serta menunjukkan tingkat energi 

yang dibutuhkan untuk proses absorpsi [8]. 

Terdapat beberapa ligan pada penelitian ini yang 

memiliki donor ikatan hidrogen lebih dari 5 dan  

akseptor ikatan hidrogen lebih dari 10, antara 

lain Benzoylmesaconine, Ginsenoside F3, 

Oleracein A, Oleracein C, Oleracein D, dan 

Xanthosine (Tabel 2).  

Log P adalah bagian dari aturan 5 Lipinski 

yang digunakan untuk memperkirakan 

kemampuan larut dan permeabilitas obat. Log P 

adalah ukuran lipofilisitas yang paling umum 

digunakan. Log P menggambarkan koefisien 

No. Kode CID Senyawa Golongan 

1. 24832659 Benzoylmesaconine Alkaloid 

2. 15558956 Dihydrogentianine 

3. - Isodidehydrotuberostemonine 

4. - Isepteropodic acid 

5. - N-cis-Feruloyl typamine 

6. 21574472 Oleracein A 

7. 21574474 Oleracein C 

8. 21574475 Oleracein D 

9. 64959 Xanthosine 

10. 5322061 2, 5, 7-Trihydroxy-6,8-

dimethyl-3-(4’-

methoxybenzyl) chroman-4-

one 

Flavonoid 

11. 5317700 Aleosone 

12. 46887678 Ginsenoside F3 Saponin 

Triterpenoid 13. 14109375 Lucidenic acid A 

14. 91439 Smilagenin 
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partisi molekul antara fase air dan lipofilik, 

seperti oktanol dan air. Sifat lipofilik obat 

memengaruhi proses farmakokinetik pada 

organisme hidup, terutama dalam proses 

distribusi. Semua senyawa yang memasuki sel-

sel tubuh mengalami hambatan lipofilik atau 

selaput sel. Hanya molekul dengan afinitas yang 

sesuai dengan membran biologis lipofilik yang 

dapat melewatinya.  

Hal ini mempengaruhi distribusi obat dalam 

tubuh manusia dan membantu zat tersebut 

mencapai reseptor [9]. Semua ligan yang diteliti 

dalam penelitian ini memiliki nilai Log P yang 

sesuai dengan aturan Lipinski, yaitu tidak lebih 

besar dari 5 (Tabel 2). Nilai Log P positif 

menunjukkan preferensi untuk lingkungan 

lipofilik atau hidrofobik, sedangkan nilai negatif 

menunjukkan preferensi untuk lingkungan 

lipofilik atau hidrofilik [9,10]. 

Aturan Lipinski terakhir adalah 

refraktivitas molar, yang harus berada dalam 

kisaran 40-130 menurut aturan Lipinski [7]. 

Refraktivitas molar tidak hanya bergantung pada 

volume molekul tetapi juga pada gaya dispersi 

London yang terlibat dalam interaksi obat-

reseptor [11]. Beberapa ligan dalam penelitian 

ini tidak memenuhi kisaran refraktivitas molar 

yang ditetapkan oleh aturan Lipinski, yaitu 

Ginsenoside F3, Oleracein C, dan Oleracein D 

(Tabel 2). Ligan-ligan ini cenderung memiliki 

penyerapan obat yang buruk. Menurut [7], ligan 

yang memenuhi 3-5 aturan Lipinski dapat 

dijadikan sebagai target pengembangan obat. 

Hasil identifikasi menunjukkan bahwa dari 

keseluruhan ligan yang diuji, 7 ligan sesuai 

dengan aturan Lipinski dan 5 ligan lainnya tidak 

memenuhi aturan Lipinski (Tabel 2). Kelima 

ligan yang tidak memenuhi aturan Lipinski 

adalah Benzoylmesaconine, Oleracein A, 

Oleracein C, Oleracein D, dan Ginsenoside F3. 

Sementara itu, ligan-ligan yang memenuhi 

aturan Lipinski adalah Beta amyrin, 

Dihydrogentianine, Xanthosine, 2,5,7-

Trihydroxy-6,8-dimethyl-3-(4’-methoxybenzyl) 

chroman-4-one, Aloesone, Lucidenic acid A, dan 

Smilagenin.  

Prediksi toksisitas menunjukkan bahwa 

terdapat 5 ligan uji yang berbahaya dan 2 ligan 

uji yang aman bagi tubuh (Tabel 3). Ligan yang 

dianggap toksik adalah Beta amyrin, 2,5,7-

Trihydroxy-6,8-dimethyl-3-(4’-methoxybenzyl) 

chroman-4-one, Aloesone, Lucidenic acid A, dan 

Smilagenine. Sedangkan Dehydrogentianine 

dan Xanthosine dianggap aman karena lolos 

prediksi toksisitas.  

Hepatotoksisitas terjadi ketika zat kimia 

berbahaya merusak sel-sel hati [12]. 

Karsinogenitas terjadi ketika senyawa kimia 

dapat menyebabkan pertumbuhan sel kanker 

dalam tubuh [13]. Imunotoksisitas terjadi ketika 

sistem kekebalan tubuh rusak karena paparan zat 

kimia. Mutagenisitas terjadi ketika senyawa 

kimia menyebabkan kerusakan DNA dan 

sitotoksisitas merujuk pada kemampuan 

senyawa untuk menyebabkan kerusakan sel 

(prediksi). 

Validasi gridbox dilakukan menggunakan 

software YASARA structure. Reseptor 

superoksida dismutase (SOD) dengan kode PDB 

ID 1CB4 tidak memiliki ligan alami yang 

melekat pada strukturnya. Validasi gridbox 

dilakukan dengan membuat kotak-kotak grid di 

sekitar residu sisi pengikatan ligan pada 

reseptor. Gridbox dibuat dengan jangkauan 0,5 – 

5,0Å dengan selisih 0,5Å. Hasil validasi 

menunjukkan bahwa kotak grid terbaik memiliki 

ukuran 3,0Å dengan nilai x, y, z sebesar 15,64Å.  

Penambatan molekuler dilakukan 

menggunakan software YASARA structure. 

Tahap awal dalam penambatan molekuler adalah 

persiapan reseptor dan ligan yang akan diuji. 

Persiapan reseptor meliputi penghapusan 

molekul air (H2O2) dan penambahan ion 

hidrogen. Sementara itu, persiapan ligan yang 

akan diuji melibatkan penambahan ion hidrogen 

dan minimisasi energi. Penghapusan molekul air 

(H2O2) dilakukan untuk menghilangkan unsur 

air dari reseptor sehingga pada proses docking 

hanya asam amino yang berinteraksi dengan 

senyawa uji. Penambahan ion hidrogen penting 

dilakukan karena interaksi yang terjadi pada 

umumnya adalah melalui ikatan hidrogen, 

sehingga diperlukan penambahan ion hidrogen 

agar proses docking berjalan secara optimal. 

Minimisasi energi bertujuan untuk menjaga 

stabilitas ikatan pada ligan uji [14, 15]. 

Dalam penelitian ini, digunakan reseptor 

superoksida dismutase (SOD) dengan kode PDB 

ID 1CB4 dan tiga jenis ligan, yaitu beta amyrin, 

dihydrogentianine, dan xanthosine. Beta amyrin 

digunakan sebagai ligan pembanding dan 

berikatan dengan reseptor pada sisi alosterik 

enzim. Asam amino yang terlibat dalam 

interaksi antara reseptor dan ligan dapat 

diketahui dari total interaksi pada beta amyrin 

yang terdiri dari 16 interaksi, yaitu 1 ikatan 

hidrogen, dan 15 ikatan hidrofobik, yang 

tersebar pada rantai A dan B. Residu yang 

berikatan hidrogen adalah Val146(A) (2.48 Å). 
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Hal tersebut sesuai dengan penelitian 

sebelumnya bahwa beta amyrin memiliki 1 

ikatan hidrogen pada residu Val146 di rantai A 

[30].  

Residu yang berikatan secara hidrofobik pada 

rantai A terdiri dari Val7, Lys9, Asn51, Cys144, 

dan Gly145, sedangkan pada rantai B terdiri dari 

Val7, Lys9, Gly10, Asp11, Asn51, Gly54, 

Cys55, Cys144, Gly145, dan Val146.  

Penelitian sebelumnya juga menunjukkan 

bahwa residu yang berinteraksi antara beta 

amyrin dengan enzim SOD adalah Val7, Lys9, 

Gly10, Asp11, Asn51, Gly54, Cys144, Gly145, 

dan Val146 [15]. 

Dalam penambatan molekuler, ligan uji 

yang digunakan terdiri dari dihydrogentianine 

dan xanthosine. Dihydrogentianine berikatan 

dengan reseptor pada sisi alosterik dan memiliki 

12 interaksi yang tersebar pada rantai A dan B. 

Dua ikatan hidrogen terbentuk pada Val146 pada 

rantai A (2.39 Å) dan B (2.38 Å). Sementara itu, 

residu   yang  berikatan secara  hidrofobik  pada 

rantai A terdiri dari Cys6, Val7, Lys9, dan 

Gly145 sedangkan pada rantai B terdiri dari 

Val7, Lys9, Asn51, Gly54, Cys144, dan Gly145. 

Xanthosine berikatan dengan reseptor pada sisi 

aktif (Asp11 (B)) dan sisi alosterik serta 

memiliki 13 interaksi yang tersebar pada rantai 

A dan B. Tiga ikatan hidrogen terbentuk pada 

Lys9 (2.87 Å) pada rantai A, serta Val7 (2.34 Å) 

dan Val146 (2.53 Å) pada rantai B. Residu yang 

berikatan secara hidrofobik pada rantai A terdiri 

dari Val7, Asn51, Gly145, dan Val146, 

sedangkan pada rantai B terdiri dari Cys6, 

Asp11, Asn51, Gly54, Cys144, dan Gly145. 

Xanthosine merupakan ligan yang dapat 

menjadi aktivator superoksida dismutase. Hal 

tersebut dikarenakan xanthosine tertambat pada 

residu Asp11 di rantai B. Residu aspartat (Asp) 

dapat berperan sebagai katalis dalam reaksi 

enzimatik pada enzim superoksida dismutase 

(SOD). SOD adalah kelompok enzim yang 

mengkatalisis penguraian superoksida (O2-) 

menjadi oksigen (O2) dan hidrogen peroksida 

(H2O2).  

Salah satu contoh enzim SOD yang 

melibatkan residu Asp dalam katalisis adalah 

SOD mangan (Mn-SOD). Pada SOD mangan, 

residu Asp yang kritis berinteraksi dengan ion 

mangan (Mn2+) dan berperan dalam transfer 

elektron selama reaksi katalitik. Residu Asp ini 

membantu dalam koordinasi ion mangan dan 

berkontribusi pada kemampuan enzim untuk 

mengkatalisis penguraian superoksida. 

Ikatan hidrogen adalah hasil dari interaksi 

antara molekul polar yang memiliki atom H 

dengan atom N, O atau F. Menurut [16,17], 

semakin banyak asam amino yang terlibat dalam 

ikatan hidrogen maka semakin kuat dan stabil 

ikatan tersebut. Ligan uji yang memiliki jumlah 

ikatan hidrogen terbanyak adalah xanthosine. 

Dalam hal ini, xanthosine memiliki 3 ikatan 

hidrogen, sedangkan beta amyrin dan 

dihydrogentianine masing-masing hanya 

memiliki 1 dan 2 ikatan hidrogen. Oleh karena 

itu, xanthosine dianggap sebagai ligan uji 

dengan ikatan yang paling kuat dan stabil 

dibandingkan dengan ligan uji lainnya. Jarak 

ikatan hidrogen pada semua ligan uji berada 

dalam kisaran 2,34 - 3,55 Å. Menurut [18], jarak 

ikatan hidrogen lebih dari 1,85 Å dianggap 

lemah dan dapat diputus untuk membentuk 

ikatan lain. Ikatan hidrofobik juga penting dalam 

menstabilkan ligan terhadap reseptor [19]. 

Pembentukan ikatan hidrofobik berfungsi untuk 

meminimalkan interaksi antara residu nonpolar 

dengan air. Residu yang terlibat dalam 

pembentukan ikatan hidrofobik biasanya berupa 

asam amino yang bersifat nonpolar [20]. 

Data hasil penambatan molekuler 

selanjutnya meliputi nilai energi bebas Gibbs 

(ΔG) dan konstanta disosiasi (kd). ΔG adalah 

parameter termodinamika yang menggambarkan 

kespontanan suatu reaksi kimia. Nilai ΔG yang 

lebih kecil menandakan semakin stabilnya 

konformasi. Semakin kecil nilai ΔG, semakin 

stabil dan kuat interaksi antara ligan dan 

reseptor, dan sebaliknya jika nilai ΔG lebih besar 

[21].  

Nilai ΔG dari semua ligan dalam 

penambatan molekuler ini berkonotasi negatif. 

Beta amyrin merupakan ligan dengan ΔG yang 

paling kecil diantara ligan lainnya, yaitu sebesar 

-8.24 kkal/mol. Nilai ΔG dari terkecil ke terbesar 

selanjutnya setelah beta amyrin adalah 

xanthosine dan dihydrogentianine. Selain nilai 

ΔG, terdapat juga nilai konstanta disosiasi (Kd). 

Konstanta disosiasi (Kd) disebut juga konstanta 

inhibisi (Ki), yaitu konstanta kesetimbangan dari 

suatu enzim dengan inhibitornya [19,20]. Nilai 

Kd berbanding lurus dengan nilai ΔG. Nilai Kd 

yang semakin kecil menunjukkan afinitas ikatan 

ligan dan reseptor semakin besar. Beta amyrin 

sebagai ligan uji memiliki nilai Kd terkecil, yaitu 

sebesar 0.90 µM. Ligan uji dengan nilai Kd 

terkecil ke terbesar selanjutnya setelah beta 

amyrin secara berturut-turut adalah xanthosine 

dan dihydrogentianine. Xanthosine sebesar 7.37 

µM dan dihydrogentianine sebesar 29.46 µM 

[16]. 
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Tabel 2. Bioavailabilitas ligan 

 

No Kode CID Senyawa 

Bobot 

molekul 

(Da) 

Donor 

ikatan 

hidrogen 

Akseptor 

ikatan 

hidrogen 

Log 

P 

Refraktivitas 

Molar 

1. 73145 Beta amyrin 426 1 1 1,40 108,20 

2. 24832659 Benzoylmesaconine 590 5 10 -0,41 128,79 

3. 15558956 Dihydrogentianine 177 0 3 0,71 42,51 

4. 21574472 Oleracein A 503 7 12 -0,88 119,65 

5. 21574474 Oleracein C 665 10 17 -3,36 150,76 

6. 21574475 Oleracein D 695 10 18 -2,87 154,53 

7. 64959 Xanthosine 284 5 9 -2,19 60,10 

8. 5322061 2, 5, 7-Trihydroxy-6,8-

dimethyl-3-(4’-

methoxybenzyl) 

chroman-4-one 

344 3 6 2,29 83,53 

9. 5317700 Aleosone 232 1 4 1,22 56,51 

10. 46887678 Ginsenoside F3 770 9 13 -4,82 170,68 

11. 14109375 Lucidenic acid A 458 2 6 -0,62 107,34 

12. 91439 Smilagenin 416 1 3 0,71 101,04 

Keterangan: Kuning : tidak memenuhi aturan Lipinski, Merah : ligan melanggar >2 aturan Lipinski 

 

Tabel 3. Toksisitas ligan 

 

N

o 

Kode 

CID 
Senyawa 

Kateg

ori 

toksisi

tas 

Hepatotoksi

sitas 

Karsinoge

nitas 

Imunotoksi

sitas 

Mutagen

itas 

Sitotoksis

itas 

1. 73145 Beta amyrin 6 Inaktif Inaktif Aktif Inaktif Inaktif 

2. 15558

956 

Dihydrogenti

anine 
6 Inaktif Inaktif Inaktif Inaktif Inaktif 

3. 64959 Xanthosine 6 Inaktif Inaktif Inaktif Inaktif Inaktif 

4. 53220

61 

2, 5, 7-

Trihydroxy-

6,8-dimethyl-

3-(4’-

methoxybenzy

l) chroman-4-

one 

4 Inaktif Inaktif Aktif Aktif Inaktif 

5. 53177

00 

Aleosone 
5 Inaktif Inaktif Inaktif Aktif Inaktif 

6. 14109

375 

Lucidenic 

acid A 
6 Inaktif Aktif Inaktif Inaktif Aktif 

7. 91439 Smilagenin 3 Inaktif Inaktif Aktif Inaktif Inaktif 

Keterangan: Merah : ligan bersifat toksik 
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Tabel 4. Penambatan molekuler 

 

No Kode CID Senyawa 
Ikatan 

hidrogen 

Ikatan 

hidrofobik 

Energi ikatan 

(kcal/mol) 
Kd (µM) 

1. 73145 Beta amyrin 

Rantai A: 

Val146 

(2,48 Å) 

Rantai A: Val7, 

Val9, Asn51, 

Cys144, Gly145 

Rantai B: Val7, 

Val9, Gy10, 

Asn51, Gly54, 

Cys55, Cys144, 

Gly145, Val146 

-8,25 0,90 

2. 15558956 Dihydrogentianine 

Rantai A: 

Val146 

(2,39 Å) 

Rantai B: 

Val146 

(2,38 Å) 

Rantai A: Val7, 

Val9, Rantai A: 

Val7, Val9, 

Gly145 

Rantai B: Val7, 

Val9, Asn51, 

Gly54, Cys144, 

Gly145 

-6,18 29,46 

3. 64959 Xanthosine 

Rantai A: 

Lys9 

(2,87 Å) 

Rantai B: 

Val 7 

(2,34 Å) 
Val146 

(2,53 Å) 

Rantai A: Val7, 

Asn51, Gly145, 

Val146 

Rantai B: Cys6, 

Asp11, Asn51, 

Gly54, Cys144, 

Gly145 

-7,00 7,37 

 
 

Gambar 1. Plot Ramachandran 
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SIMPULAN 

Berdasarkan LC/MS, telah 

diidentifikasi 14 senyawa pada batang 

krokot. Sebelas senyawa di antaranya dapat 

ditemukan pada database PubChem. Dengan 

menggunakan http://www.scfbio-

iitd.res.in/software/drugdesign/lipinski.jsp, 

7 senyawa yang stabil telah diidentifikasi 

melalui identifikasi bioavailabilitas.  

Dua di antaranya dinyatakan aman 

berdasarkan prediksi toksisitas ligan 

menggunakan ProTox II webserver. Dalam 

penambatan molekuler dengan perangkat 

lunak YASARA structure, senyawa 

xanthosine menunjukkan potensi sebagai 

aktivator enzim SOD.  
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